
ab

Stay ahead with Agfa Global Services.	 Training Manual

Wasatch

SoftRIP AE 6.0



Wasatch SoftRIP AE 6.0	 Stay ahead. With Agfa Global Services.

	 �	 Table of Contents



Stay ahead. With Agfa Global Services.	 Wasatch SoftRIP AE 6.0

Table of Contents	 �



Wasatch SoftRIP AE 6.0	 Stay ahead. With Agfa Global Services.

	 �	 Table of Contents



Stay ahead. With Agfa Global Services. Wasatch SoftRIP AE 6.0

Installation �

1. Installing the Wasatch SoftRIP AE.
Before installing the software, obtain your registration codes from www.wasatch.com or fax 
the form, included in the software box, to 001 801-�7�-807�. The serial number of the Wa-
satch SoftRIP is displayed on the front side of software box. When you obtained the registra-
tion codes, the installation can be started. 

Make sure that the Wasatch version you’ve received is in fact the Agfa Edition (AE) of the Soft-
RIP.  Check the CD-rom: if an Agfa label is present, you can use the CD-rom for the installation. 
If there’s no Agfa logo on the disc, you should download the Agfa version from -

. Execute the SRIP60.exe file that you can find in the “Wasatch 6.0 
released” folder. After the installation, the Wasatch SoftRIP will be launched and the registra-
tion window will pop up. Enter the registration codes. The software will confirm the validation 
of the codes and it will ask you to restart the program. Re-launch the application and select 
your correct type of the :Anapurna engine (L or XL). 
The last step to complete the installation, is to copy the Agfa standard settings into the Wa-
satch SoftRIP folder. You can find these settings in the Wasatch 6.0 released folder. Copy the 
agfaoem1 folder into x:\wwrip6\configurations and restart the RIP. 

1.1 Step by step.  
Insert the CD-rom or download the software from -

If you download the software, you have to execute the SRIP60.
exe file. Winzip will ask you for a location to unpack the zipped 
file in a /Wtemp folder.

When the files are unzipped, you will find an install.exe file in the /Wtemp/
SRIP60. If you run this file, the Wasatch installation window will pop up. When 
you’re using the CD-rom, this window will automatically pop up.

After clicking on the install button, a message window will open 
asking you to attach the hardware key (dongle). Select 1 or more 
languages in which you want Wasatch to run. After you’ve chosen 

the right language, Wa-
satch will tell you that 
there was no previous 
version of the SoftRIP 
found and will  ask you if 
it has to search for one. 
Choose ‘no’, otherwise 
the installation software 
will start scanning your 
entire hard drive. 








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Select a destination folder and drive. The installation will start,  copying files 
onto the destination drive and into the destination folder. You will also find two 
new folders on the root directory of the defined drive: ‘incoming’ and ‘psfiles’. 
The second one contains postscript files for various calibration tools: dtp41, 
eyeone,...
Run the Wasatch SoftRIP for the first time, choosing the Wasatch SoftRIP icon 
in the start menu of Windows.
The SoftRIP will ask  you to enter the registration codes that you obtained from 
Wasatch.

If correct codes are entered, a window will pop 
up with the message that valid codes were en-
tered and the Software has to  be restarted.
When you start the Wasatch SoftRIP for the 
second time, the setup will automatically ap-
pear asking you to initialize your engine :
Anapurna L or XL. Choose the right engine and 
exit the software.

You will see that Wastach will have generated a new folder ‘configurations’ in 
the destination folder ‘wwrip6’. In the ‘configurations’ folder you can find the 
‘agfaoem1’ folder. This is the place where the imaging configurations are saved. 
You will see that only the ‘none’ configuration will be present. Copy the Agfa 
standard configurations, available on the ftp-server, in this folder.
Restart the Wasatch SoftRIP.




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1.2	Mapping a network drive.
The Wasatch SoftRIP will not directly communicate with the :Anapurna engines. RTL-
files will be sent to the :Anapurna Control Panel, which will operate as a print queue. 
The easiest way to work is to generate a shared network folder on the :Anapura PC, 
which will be used as an output folder for the Wasatch SoftRIP.

Create a folder called “RTL” on the Anapurna PC. Right click on 
the folder and choose Properties. The properties window will pop 
up where you can share the folder.

On the Wasatch RIP PC you have to create a mapped networked 
drive to the RTL-folder on the Anapurna PC: open windows ex-
plorer and go to “Tools\Map Network Drive”.

Choose a drive letter which is not 
yet occupied and hit the browse 
button.

Browse to the Anapurna PC and se-
lect the shared rtl-folder. Click OK 
and finish. The RTL folder on the 
Anapurna PC is now mapped to the 
Wasatch RIP PC.

As an alternative you can also enter 
the IP address into the folder drop 
down list. eg. \\10.232.173.20\RTL.

Start up the Wasatch SoftRip and 
choose “Setup” out of the print menu. 
Select an imaging configuration (it 
doesn’t really matter which) and click 
the edit button beside it. The Imag-
ing configuration window will pop up 

where you have to select the option ‘properties’. On the bottom of 
this window, you can select the mapped drive volume. Choose the 
mapped drive and close all open windows. Wasatch will automatically 
set the same output drive for all the different image configurations 
(see 5.2.2).








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2.	Main Window - overview.

2.1	Different parts.
SoftRIP’s Main Screen is briefly described below. These menus and controls are cov-
ered in more detail throughout the manual.

a.	 Menu items.
File:	 Use the File menu for opening files 

saved on disk or network. Files opened 
here are automatically displayed as 
screen previews when the Job tab is active, or imported to the current 
layout when the Layout tab is active. This menu also provides access 
to the Print Archive tool, and the Preferences window for changing op-
tional settings.

Image:	 The Image menu contains tools for modifying the image currently open 
in the Job tab, or currently selected in the Layout tab.

Color: 	 The Color menu contains key SoftRIP color tools for managing spot col-
ors, color gamut, correction curves etc.

Print:	 Access to printer and Imaging Configuration set up, RIP/processing op-
tions and job queues.

Page:	 When active, enables switching among different pages of a multi-page 
PostScript file.

Layout:	 The Layout menu accesses automated Smart NestingTM tools, and other 
features to speed the process of creating efficient layouts.

Server: 	 Set up and activation for Hot Folders and Wasatch ImageNET.

Language: 	 When enabled, the Language menu selects among non-English lan-
guages.

Help:	 Accesses online Help, program info, Service Data Uploader and online 
product registration. 
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b.	 Universal Controls.
Unit Window:   Selects the printer to use for current job or layout processes. SoftRIP 

drives up to four printers.

Queue Processing Active:  Unchecking this checkbox will completely shut down all 
new jobs from processing in the queues! Under normal conditions, this 
box is checked. When unchecked it flashes red. All processing stops 
when Queue Processing Active is unchecked. Uncheck the box to stop 
all printing in order to change system configurations or re-prioritize 
jobs.

Tool Bar: 	 Buttons on the tool bar are active or grayed-out depending on various 
selections of the tabs found below them on the main window. All tool 
bar operations can also be accessed from menu selections within the 
program, and all are documented with tool tips.

c.	 Top tabs.
The tabs along the left and upper edges 
of the main window include many of the 
key file preparation and workflow tools in 
SoftRIP. Based on your top tab selections, 
tabs along the left of the screen may ap-
pear, disappear, or modify.

Job Tab: 	 When the Job tab is selected, you can open an individual input file, or 
job, to be prepared for printing. With the Job tab selected, a full set of 
options for sizing, cropping, scaling, and tiling appear.

Layout Tab:  When the Layout tab is selected, you use the full width of your media 
as a digital canvas upon which you can prepare images to print as part 
of your complete production run. With this workflow, you can easily 
drag and drop images into the layout, manipulate them, and nest them 
to fit efficiently as part of your overall print run. The entire Layout can 
then be submitted to RIP and print.

Queues Tab:  When the Queues tab is selected the view becomes the master pro-
duction control station of the RIP. On the Queues tab, all RIP and Print 
queues are displayed with the status of each job updated in real time.

d.	 Left tabs.
System Tab:  Displays the status of all printers and job 

queues.

Unit Options Tab:  Includes settings for immediate 
or delayed nesting printing, annotations, 
crop marks, and registration marks.

File Browser Tab:  Lets you quickly drag and drop files 
into the Job, Layout, or Queues windows.

Info Tab:  	 Displays information about an open job, 
including real-time values for input and 
output color at any point on the previewed 
image.

Size Tab:  	 Controls sizing, cropping, rotation, and 
mirroring for the current image on the Job 
tab.

Tile Tab:	 Provides controls for “paneling” or “tiling” 
print jobs that are too wide for the current 
printer.
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3.	Left Tabs.

3.1	System tab.
The system tab displays the status of all printers and job queues. 
You can define up to 4 different engine units in the Wasatch Soft-
RIP. You can, for example, generate a new printing device for ev-
ery quality mode on the :Anapurna engine:
	 - 6 pass printing mode
	 - 8 pass printing mode
	 - 12 pass printing mode
	 - 16 pass printing mode 

3.2	Unit Options tab.

a.	 Unit Options
Some key print unit settings are located on the main window 
Unit Options tab to for easy access. These settings are print 
unit specific, and you can change between units by clicking 
the unit number buttons on the tab itself. The controls on this 
tab are detailed below.

b.	 Immediate Print
Checking the Immediate Print box will start sending output 
to the printer as soon as the RIP begins producing dots. When 
this box is unchecked, printing will begin only after the entire 
image has finished RIPing. With immediate print, the device 
may pause during printing while it waits for data from the RIP. 
With some printers this may cause problems with print qual-
ity. Immediate print is not an available option when printing 
layouts.

c.	 Hold For Layout
When Hold For Layout is checked, jobs will not begin printing 
from the Print Queue until they are sent to print as part of a 
layout. Jobs held can then be included in layouts individually, 
or you can click the Layout Queued Job(s) button above the 
Print Queue to send all jobs listed with quantities to print to 
the layout screen. Learn more about SoftRIP’s time and media 
saving nesting options in the layout section of online help. 
Note that checking this control will only suppress printing of 
individual jobs; layouts will not be held from printing.

d.	 Single Row Nesting
This automated nesting feature helps to save media without requiring the user to 
trigger the printing process. Jobs sent to print will be held until enough images 
have been queued up to fill the width of the media. Setting a value in the Gap win-
dow will determine the distance left between nested images. To trigger jobs nested 
in the row to print before the full width is achieved, click the Force Nested Output 
button.

e.	 Marks and Annotations
The settings in the Marks section are also located on the Set-
up screen, and are detailed above.

3.3	File Browser tab.
Using the file browser tab, you can quickly search and open im-
ages. You can simply select an image in the file browser tab and 
drag onto the preview window. If an image does not require any 
file preparation, you can drag and drop it directly from the file 
browser tab to a RIP Queue. You will be asked whether or not you 
would like to generate a preview. If you select not to generate a 
preview, the image will display as “Preview not available” when 
added to a layout.
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3.4	Info tab.
The info tab provides information about an open job. It displays: 
the path & name, size & creation date of the file. The Input/Out-
put lines show color values at your cursor position on the preview 
image; it changes continuously as the cursor moves. The Input 
line shows exactly what type of input file is embedded at any spe-
cific point in your image. Wasatch SoftRIP can correct incoming 
Raster RGB, Raster CMYK, Vector RGB and Vector CMYK images 
independently, even when they are mixed on the same image. 
The Output line shows the equivalent values in the color space of 
the output device.
PostScript allows a single input file to express colors in several 
different ways. For example, a QuarkXpress page may have graph-
ic design elements and spot color defined in Vector CMYK, but 
also contains embedded images from Adobe Photoshop defined 
as raster RGB images.

The Input/Output display tells you instantly what color spaces 
your incoming files contain or which parts of any one mixed-color 
model file are which. The Input line shows you the exact color 
specification in the original file prior to being touched by Wa-
satch color management, whether it is CIE, RGB, CMYK, or other. 
The Output line shows exact color at that point, which will result 
from the current Imaging Configuration.
If you are using ICC device profiles (the normal color manage-
ment method within Wasatch SoftRIP), the “PCS, D50 CIE Lab” 
display shows the value of your color in the ICC “Profile Connection Space”. This can be 
valuable for isolating color reproduction problems due to input and output ICC profiles.

Out of Gamut warning.
SoftRIP’s Out of Gamut warning alerts you when a color simply can’t be reproduced on 
your current output device. The Gamut display indicates “In Gamut” when a match is 
possible; it shows the expected Delta E error in red when a color is outside the printer’s 
color range. 

3.5	Size tab.
The Size tab contains several key features that scale and other-
wise transform images prior to printing. The Size tab automatical-
ly appears on the Main Screen whenever a file is opened. These 
utilities are found on the Size tab: Sizing (or scaling), cropping, 
rotating and mirroring.

a.	 Scaling.
To enlarge or reduce an image, enter a new value in the win-
dow next to the Scale Percent heading. Your ENTER or TAB 
key activates the change. The new dimensions are displayed 
in the Width and Height windows in the Output area, while the 
original dimensions are displayed next to Width and Height in 
the Crop area. If your scaling percentage will produce an im-
age larger than the printer’s maximum output format, SoftRIP 
alerts you by marking the surplus area with a red and black 
flashing crosshatch. You must either reduce the scaling per-
centage, or use the Tiling feature.

Computing Scaling Percentage Automatically: SoftRIP will 
size an image if you enter the desired width or length of the 
final print in either the Width or Height windows in the Output 
area. For example, you can enter the printable width of your 
print media or one dimension of a light box or display hard-
ware. Make sure the Constrain Proportions box to the left of 
the Width and Height boxes is checked, then press ENTER or 
TAB to activate the change.

The new percentage appears in the Scale Percent window, while the other dimen-
sion (either Width or Height) is displayed in the appropriate window. A cropping 
marquee also appears around the entire image (see Cropping, below). You only need 
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to enter one dimension in an Output window (Width or Height); if you attempt to 
enter a value in the other, SoftRIP activates the automatic scaling process. For au-
tomatic scaling to work, the Constrain Proportions box next to the Output windows 
must be checked.

b.	 Cropping.
This tool defines a smaller area of the original image and prints only that area. This 
is true cropping, because only the selected area will be RIP’d. This saves RIPing 
time and is an excellent tool for printing test strips for color evaluation. The crop-
ping tool can also be used to magnify selected areas of the image (see below under 
Zoom into Crop Box).

Adjustment modes: There are two options for adjusting marquee borders: free or 
proportional. Free means that the marquee edge you select moves independently 
of other edges. Proportional means the width and length stay proportional to the 
original dimensions of the marquee. The mode of marquee adjustments is selected 
in the Constrain Proportions boxes, the same way that image width and height are 
locked during scaling. Check the Constrain Proportions boxes to select a propor-
tional mode; uncheck them for free mode. You may also right-click inside of the 
marquee, which will open a popup menu (the other selections on this menu are de-
scribed below). Selecting Constrain Proportions On corresponds to the proportional 
mode, and automatically places check marks in the boxes.

Left-click on the preview image: activate crop area.
Activate the crop area by left-clicking anywhere in the image and 
dragging your mouse to create a dotted line “marquee” box. The mar-
quee defines the area to print, or an area to zoom into. Re-position 
the borders of the cropping marquee by holding down the left mouse 
key and dragging. The Width and Height windows in the Crop area 
display the size of the marquee dimensions on the original image. 
The Width and Height windows in the Output area display the size 
of the crop marquee dimensions. Only the area inside the marquee 
will print.
Matching specific display dimension requirements: For more precise 
adjustments, enter new dimensions in either the Width or Height 
windows in the Output area. This must be done in the Free mode 
(Constrain Proportions turned off). The dimensions of the marquee 
will not change until you press ENTER or TAB.

Changing marquee position manually and numerically: The entire 
marquee area can be re-positioned by clicking in the centre of the 

marquee and dragging the marquee box. The position of the marquee’s left and 
bottom edges are displayed in the windows labeled Left and Bottom in the Crop 
area. The numbers shown represent the distance in inches or centimeters, mea-
sured from the respective edge of the original image to the outside border of the 
marquee.

Change the marquee position more precisely by hand-entering new values in 
these windows. When you enter new numbers to position the marquee, the mar-
quee will not move until the ENTER or TAB key is pressed.
When a crop marquee is “live” on an image preview, right clicking within the 
marquee launches the popup menu.

Right-click on the preview image: pop up menu.
Right-clicking on the image, will open a pop up menu which offers you the next 
options:

Zoom Into Crop Box: eliminates areas outside the 
marquee and allows you to zero in on specific ele-
ments of the image. Especially useful for color cor-
rection and spot color replacement.

Delete Crop Box: makes the marquee go away and 
resets the Crop and Output dimensions.

Constrain Proportions On or Constrain Proportions 
Off: toggles between free and proportional reposi-
tioning of the marquee borders.








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Expand Page:  places a white border around the edges of the image.

Replace Spot Color: launches the Special Colors menu and spot color man-
agement features.

Correction Curves: launches the Correction Curves menu.

Profile View:  launches the Profile View Utility.

c.	 Restore Original View.
This option takes you back to the original view of the image.

d.	 Rotating.
Rotating a landscape image 90° into a portrait format may al-
low you to print the image in a larger size without tiling. The 
other rotation degrees allow you to re-position an image that 
is upside down or otherwise incorrectly oriented. To select a 
rotation value, click the corresponding radio button. The ef-
fect is immediate (does not require pressing the ENTER or TAB 
key). Rotation in SoftRIP always works counter-clockwise and 
is not cumulative. Whatever value you select will be applied 
based on the original position of the image.

e.	 Mirroring.
This feature flips the image over. It is used primarily for print-
ing backlit transparencies or other second surface applica-
tions. It is also used for images to be transferred to another 
substrate, such as fabric.

f.	 File Preparation Using the Layout Workflow
The Size tab is not accessible when the Layout tab is active. If you right click on an 
image on the Layout tab and select Size/Crop SoftRIP will transfer the image to an 
“Image from Layout” tab. In this view, the Size tab is enabled and file preparation 
tasks can be carried out. To accept changes and return the image to the Layout tab, 
click the Update Layout button. The image returned to the layout will automatically 
update with the changes.

3.6	Tile tab.
This tool is used to produce multi-page (multi-panel) enlarge-
ments of prints, where the desired output is wider than the width 
of the media or the printer.

If the image is wider than the output device can print, the area 
that is unprintable is indicated on the screen by a flashing red 
hatch mark. The width of the output device depends on the kind 
of engine that’s installed: the :Anapurna L has a width of 1600 
mm (63 inches) and the width of the :Anapurna XL is 2500mm 
(98,43 inches).

By selecting the Tile tab and by then 
right clicking on the image, you can 
launch the popup menu. When selecting 
‘cut vertically’ or ‘cut horizontally’, you 
will split the job in the selected direc-
tion. A dotted line will appear, indicating 
the position of the tiling.

Precise numeric values for the width and 
height of columns and rows can be en-
tered by selecting Adjust Column and 
Adjust Row. 

If you want to reposition a tiling line, you can left-click and drag 
it on the preview. Right-clicking on a tiling line, will give you the 
option to delete it. You can also determine the tilling parts by us-
ing the settings in the tile tab. 






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You enter the amount of tiling parts you want to become in the ‘across’ (horizontal) and 
‘up’ (vertical) box. The ‘tile overlap’ box will determine how much the different tiling 
parts will overlap. This overlap represents the overprint of each tile, providing a safety 
area for later trimming and alignment of the prints. Note that the centre tile has two 
overlaps added (one for each side), while the other two tiles only have a single overlap, 
which will be printed on the edge that abuts another tile.

Above these settings, you get a read out of the ac-
tually width and height of the tiling parts. You can 
always alter these values by left-clicking on them. 
A measurement adjustment window will pop up 
that allows you to enter a precise width for that 
column of tiles.

If the ‘Rotate Alternate Columns’ box is checked, 
alternate columns of tiles will be rotated by 180 
degrees. This is valuable with print modes that pro-
duce slightly different colors at right and left edges, 
reducing the visibility of this effect when tiled jobs 
are assembled. After tiles have been added to the 

RIP Queue, individual tiles can be opened for adjustment of their overlaps. The overlap 
adjustment controls are found at the bottom of the RIP Queue window for the indi-
vidual tile (see 5.1).

You can select or deselect individual tiles to print by simply 
clicking on individual tiles with the left mouse button or on the 
corresponding check mark under All Tiles. Full rows or columns 
can be toggled by clicking the right mouse button on a tile, and 
selecting Print Row or Print Column. Tiles marked with a red X 
will not be printed.
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4.	File Menu.
Besides opening and closing files, the file menu also gives you the possibility to :

open a twain source;
define preferences;
archive jobs.

The previous 8 jobs are displayed at the bottom of the menu.

4.1	Twain Source.
With this feature, you can capture images 
from Twain-compliant scanners and digi-
tal cameras directly from within Wasatch 
SoftRIP. Twain Source is located under the 
File menu of Wasatch SoftRIP. Clicking on 
Twain Source will launch a window from 
which you can import scans.

Save image after scan.
This allows you to save the scanned file to a TIFF file in a directory of your 
choice. (Default is off.)

Use scanner interface.
If your scanner allows it, this option forces the scanner to start scanning using 
its default settings. In most cases, you will want to use the scanner’s interface 
to setup the scan. (Default is on.)

Disk buffering.
If your scanner allows it, this option allows you to scan in images that are larger 
than may fit in your physical memory. This increases the scanning speed for 
large images. Scanners which do not support this feature may fail when trying to 
scan using this option. (Default is off.)

Click on Choose Source, to select your scanner/digital camera. After you select the 
source file, click on Acquire Image. If ‘Save image after scan’ is checked, you will be 
asked to provide a filename into which the scanned image will be saved.

The scanner/digital camera interface unique to your scanner/digital camera should 
then be launched. For guidance on using this interface, consult the user manual for 
your scanner/digital camera. After the scanner/digital camera is finished transferring 
the image, click on Open to open the scanned image directly into SoftRIP.

4.2	Preferences
The Preferences window gathers control of a variety of system settings under the File 
menu. Below is a listing of the settings included in Preferences. Note that prior to Soft-
RIP version 6.0 these controls were located in the Options menu. 

DCS and Image Format Options
This control allows you to specify how certain file formats (DCS2, PSD, and TIFF) 
will be interpreted.

Edit Plate Color Table
This tool allows you to reassigning the mapping of PlateColor when making 
color separations in application software. See the Color Separations section of 
online help for more information on this setting.








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Font Substitution
This window controls the way the RIP performs sub-
stitutions for unrecognized fonts requested by a 
PostScript file. 

When a font request is unresolved, the RIP looks 
first in the Specific Font Substitutions window. If 
the font is found there, the specified substitution 
is performed. If the font is not found there, the font 
specified in Default Font will be used. The Default 
Font can be chosen from all the fonts installed on 
Wasatch SoftRIP.

It is particularly important that fonts using large cha-
racter sets, such as Japanese, are always substituted 
by other fonts that contain similarly large character 
sets. If you allow Helvetica to be substituted for an 
Asian font, you will lose a lot of characters.

Anytime the RIP performs a font substitution, a line 
for that substitution is placed in the Specific Font 

Substitutions window. This is done whenever SoftRIP previews a file or process-
es for output. After previewing, clicking on any line in the Specific Font Substi-
tutions window allows it to be edited.

This window displays the current substitution and a list of all the fonts installed 
on Wasatch SoftRIP. You may select a new font to be substituted or delete a 
specific substitution by clicking that button.

Important note for Asian typesetting users: When choosing substitutions, try 
to match the Encoding extension of the original. That is -83pv-RKSJ-H in most 
Japanese files from Macintosh.  

Image File Interpolation
When bicubic interpolation is enabled, incoming raster images (such as TIFF and 
PSD) are average point-sampled, to help reduce jaggy edges.

Lock Controls
Lock controls allows you to password protect setup and color settings in Soft-
RIP. SoftRIP’s Set Up menu allows you to select multiple print modes for most 
printers, as well as multiple combinations of inks and substrate. This creates the 
potential for wide variations in color and image quality behaviors, especially in 
shops in which many users share SoftRIP. SoftRIP’s locking key controls provide 
some control for this problem.

Checking Lock System Default ICC Profiles locks 
that window. This lock can also be enabled or dis-
abled with the Lock button on the System Default 
ICC Profiles window.

Checking Lock by Print Unit boxes affects the cur-
rent print unit as follows:

Printer Model locks both the Properties button 
and Printer Model on the Set Up screen.
Imaging Configuration locks the Imaging Con-
figuration selection on the Set Up screen.
Physical Connection locks that control on the 
Set Up screen.

Changes to these settings can only be made if a va- 
lid password has been entered in the password field. 
Otherwise, the OK button will issue a warning, with 
no other effect. If a valid password has been entered, 
and a new password has been entered identically in 
the Change Password box, the new password will 
take effect.

When Wasatch SoftRIP is installed, the password is ‘pass’. If you lose or forget 
your password, contact Wasatch customer service at ‘wct@wasatchinc.com’ for 
instructions on resetting to ‘pass’. This password protection will discourage ca-
sual resetting of the controls, but it is not secure against even the most casual 
‘hacking’.












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The password set in this window also controls the Lock Imaging Configuration 
window which is launched from the Lock/Unlock button on the Imaging Con-
figuration screen.
Imaging Configurations are shipped “pre-locked”. You will not be able to make 
changes to the Configurations shipped with SoftRIP. When you modify an Imag-
ing Configuration and rename it, you create a new Configuration that can be 
Locked or Unlocked.
NOTE: Imaging Configurations are shipped “pre-locked”, meaning that you will 
not be able to make changes to the Configurations that ship with SoftRIP. When 
you modify an Imaging Configuration and rename it, you are creating a new con-
figuration that can then be Locked or Unlocked.

Memory Tuning
This control allows you to specify the amount of sys-
tem resources given to each RIP process and set the 
number of RIP processes that can be launched si-
multaneously.

Roll Feed Counter
This tool helps you to keep track of how much media 
has been printed through the RIP, and determine if 
you have sufficient media to complete queued jobs.

Set EPS Border
Since EPS images do not have a defined PostScript 
page size, you can add a (white) border to these im-
ages by specifying a value here.

Unit of Measure
Set the unit of measure as Inches, Centimeters, or 
Millimeters. This setting is global for all settings in 
SoftRIP, unless specified otherwise.

4.3	Archive

a.	 Introduction.
The Print Archive is a utility designed to back up RIP’d files to other drives. Rip’d 
images are very large files and can take up a significant portion of your hard drive.  
Since the RIP process can be time consuming, it is often desirable to keep the RIP’d 
files so that reprinting can be done quickly, without the need to re-RIP the image 
file.  

b.	 Running the Print Archive.
The Print Archive is accessed by selecting Archive undcer the File menu. When you 
click on Archive, the main Print Archive screen will be displayed.

c.	 Window Layout.
The check buttons in the upper left corner of the window correspond to each of the 
4 print units. Check only the units you want displayed. The four tables on the left 
side of the window correspond to the four print units and shows the jobs currently in 
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each queue. The tables on the right side of the window show the jobs in the archive 
folder. The window above the archive table shows the folder where the archived 
jobs will be stored. The Browse button allows you to select the archive folder.

d.	 Operation.
Select the jobs you would like to copy by clicking on them. If you hold down CTRL 
while you select a job, multiple jobs will be selected. To select a range of jobs, click 
on the first job, hold down SHIFT, and click on the last job.

To copy jobs to the archive, click the right-pointing arrow next to the print queue 
you would like to copy from. To copy jobs from the Print Archive, click the left-
pointing arrow next to the print queue you would like to copy to. You can also drag-
and-drop items between the print queues and the archive.

When you copy jobs from the archive back to a print 
queue, you may be presented with an error message. This 
indicates that the Print Queue is no longer set up as it was 
when you originally copied the files.

Before you can re-copy the job for use, you will need to set 
up your Printer Model and Imaging Configuration to the 
same printer model and configuration that was used when 
the job was originally RIP’d.

To aid you in doing so, the original printer 
model and imaging configuration are dis-
played in this message.

To remove jobs from either the Print Archive 
or the print queues, select the jobs you 
would like to remove. You can either press 
the Delete key on the keyboard or click the 
right mouse button, then click on Delete 
Jobs.

To view a job’s properties, double-click on 
the job in the rip queue or click the right 
mouse button, then click on Job Properties. 
The job properties window shows you a pre-
view of the job (if available) and file infor-
mation. It also allows you to Delete the job 
or rename the job. If the job is in a location 
that is read-only (such as a CD-ROM), the 
Delete button and the notes field will be grayed out. After you have organized your 
jobs, click on OK. The jobs will then be copied to the appropriate locations. A prog-
ress bar will show up while the copy operation is taking place.

WARNING: RIP’d jobs can be huge, and may take several minutes to copy! Do not 
attempt to close the window while the progress bar is present (even if it may not 
appear to be moving). Doing so risks corrupting your files! 

e.	 :Anapurna archive.
When printing on the :Anapurna, RTL-files will be generated and copied unto the 
Anapurna’s hard-drive. Making a backup of these RTL-files, is also a way to archive 
your RIP’d data. 
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5.	 Image Menu.
Depending on the modus (Job or layout) where you’re in, dif-
ferent kind of features will be enabled or disabled. The job 
mode will enable the features ‘add to layout’, ‘rotate left’, ‘ro-
tate right’ and ‘mirror. When you’re working in a layout and 
you’ve selected an image, only the ‘add to layout” option will 
be grayed out.

5.1	Add to Layout (job mode).
When you’re editing an image in the job modus, you 
can choose to add this image to a manual layout. You 
will see that the image will appear onto the layout grid, 
that you can access by selecting the layout tab.

Use this feature if you want to combine multiple imag-
es into one ripping job. The usage of the manual layout 
settup will be further discussed in the chapter Manual 
Print Layout (see x.x).

5.2	Size/Crop (layout mode).
When you’re working the layout mode, the size/crop 
feature will give you the possibility to alter an image 
that was already added to a layout.

When you select the size/crop 
option when there is still an 
image open in the job mode, 
Wasatch will ask you to close 
this image. A new ‘image 
from layout’ tab will pop up 
and the rescaling settings will 
become accessible on the left 
side. After editing the image, 
click ‘update layout’ and the 
new settings will be applied 
on the selected image. 

5.3	Rotate and Mirror (job and layout mode).
The features ‘rotate left’, ‘rotate right’ and ‘mirror’ will you allow to change your image 
as such. In the job mode, the image that is open will be altered. If you’re working in a 
layout mode, you will change the image that has been selected.

5.4	Position (layout mode).
Allows you to position your image onto the layout grid, 
using the ‘set job position’ screen.

5.5	Quick Size (layout mode).
The quick size window will pop up if you select this feature. You can 
quickly change the dimension of your selected image in a propor-
tional way, using scale percentage or changing the width or heigth of 
your image. The preview of your image will automatically be updated 
by clicking OK.
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5.6	Tile (layout mode).
When you’ve already added an image to a layout, you still can apply the tiling func-
tion by selecting Tile in the image menu. The ‘image from layout’ window will pop up, 
displaying the tile option in the left tab. The usage of tiling is discussed in the Left Tabs 
chapter (see x.x).

5.7	Duplicate, Add Copies, Delete (layout mode).
If you use the duplicate feature in the layout mode, an exact copy 
of the selected image will appear in the preview screen. If you want 
more then one extra copy, you can select the ‘Add Copies’ option. 
You will be asked to enter the number of copies you want to add. 
Delete, will delete the image that has been selected.
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6.	Print Menu.
The Print Menu gives you the choice between differ-
ent output options:

RIP AND PRINT.
A PostScript Interpreter bar launches 
on your task bar during RIPing, then 
a Print Spooler bar. Clicking on these 
bars opens windows that provide in-
formation regarding the progress of 
the job. 

RIP ONLY.
To RIP a job without printing it, select 
RIP ONLY from the Print menu. The job 
will be RIP’d and added to both the 
RIP and Print Queue listings on the 
Master Queues screen (more below).

ADD TO RIP QUEUE.
To add a job to the RIP Queue to be RIP’d later, select ADD TO RIP QUEUE from 
the Print menu. It will be added to the RIP Queue but not RIP’d.

6.1	Setup (the setup screen).
The Setup screen is the window where you select the Printer Model and Imaging Con-
figuration. Further controls related to both the printer and the Imaging Configuration 
are accessed from the Edit button next to Imaging Configurations. Those features are 
described in Imaging Configurations.

Launch the Setup screen from the Print menu at the top of the Main Screen. After se-
lecting the printer model (:Anapurna L of XL), you can choose the correct Image Config-
uration. Working with an :Anapurna engine, the Physical Connection box will be grayed 
out and will display ‘RTL Files Unit x’. You don’t have to define a TCP/IP location, be-
cause the :Anapurna is not physical connected to the Wasatch SoftRIP. You can define 
the path of the output folder in the properties option of the ‘Imaging Configuration’ 
window. You should share a network folder on the :Anapurna PC so the RTL-files will be 
written directly to the engine’s PC.
Several other important controls are found on the Setup screen:

a.	 Print Margins.
Paper Width :  The Paper Width control normally specifies the maximum print 
width for the current printer, but you may manually enter a smaller number. This 
practice is recommended to make sure Auto Nesting works properly with narrow 
media rolls.

Left, Top & Bottom Margin :  Entering values for the Left, Top and Bottom 
margins moves the image in the specified direction when printing. Printing on 
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the :Anapurna, these settings are not applicable because Wasatch will be out-
putting RTL-files. The settings will on be applied when a printer is physically 
connected to the SoftRIP.

b.	 Scale Adjustments (percent).
Scale adjustments : These controls are used to associate small, precise scale 
factors with given Print Units. These scale factors are intended to compensate 
for distortions that occur with various specialized printing processes.

c.	 Marks.
Crop Marks : Checking Crop Marks places corner marks on all prints, in order 
to assist trimming. In the case of tiled jobs, these marks indicate the overlap 
gap and the cut lines. Checking the Full Length option extends crop marks as 
a hairline across the image to allow easier cutting. For tiled images, the trim is 
printed as a hairline and the gap overlap is indicated by a dashed line.

Register Marks : Checking Register Marks will cause such marks to be print-
ed. These can be very useful in situations where Wasatch SoftRIP is used to cre-
ate color separations.

Annotate Prints : Checking Annotate Prints causes ex-
tra information about your jobs to be printed at the foot of 
those jobs. Pressing Annotation Details launches the Annota-
tion Details window. For most high-resolution inkjet printers, 
printing at 8 lines per inch (small type), will produce clear text 
and also conserve paper. For lower resolution print modes, a 
smaller number of lines per inch with larger type may be pref-
erable. Up to six lines of information may be printed, in one of 
four different typefaces. Selecting One Line prints all informa-
tion on a single line if possible.
A message may be entered in the Unit Comment window 
describing job conditions or other information. In addition a 
Job Comment message can be added in the RIP Queue edit-
ing window as described in that section. Both comments will 
print when text is entered in the respective windows.

CMYK Vector Test Pattern : Checking this box adds the 
CMYK test pattern to the printed annotation data. This pattern 
has been designed so that it is subjected to exactly the same 
CMYK vector color management as the main image. This is 
critical to quality assurance for color workflows that involve 
simulation.

Cutting Options.
Cutting Options Settings : The settings in the lower right sector of the Setup 
screen control cutting functions when SoftRIP’s optional Contour Cutting fea-
ture has been enabled.

6.2	Editing Image Configurations (The Imaging Configuration Screen).

The Imaging Configuration is an important setting that allows you to choose pre-con-
figured profiles that match your ink, media and other print settings. When you access 

the Imaging Configuration drop down window 
on the Set Up screen, you will see a list of 
Imaging Configurations for the printer model 
you have just selected. If you install the Agfa 
version of the Wasatch SoftRIP, 20 standard 
image configurations are enabled.

The pre-configured Imaging Configurations 
can be edited in a number of ways, including 
key controls accessed from the Imaging Con-
figurations screen.
Choose an image configurations and select 
‘edit’, if you want to make chances to the 
selected profile. The Image Configuration 
screen will pop up. It accesses controls for 
specific printer settings and color workflow 
controls.
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a.	 Printer Properties.
Pressing the Properties button next to the printer model name launches control 
panels with additional settings for the printer. You can find 8 different Print Mode 
settings for the :Anapurna engine. The first part of the print mode name, defines 

the number of colors which will be used: 
CMYKLCLM or CMYKLCLMW. The only differ-
ence between these two, is the use of white 
ink (W). The second part displays the resolu-
tion in which will be ripped and printed:	

	 - 363 x 272 = 6 pass

	 - 363 x 363 = 8 pass

	 - 363 x 545 = 12 pass

	 - 363 x 727 = 16 pass

If you select a print mode using white ink, the white ink 
options will become available (CMYKLCLMW). 

No Auto Generation (use in-line head)
No Auto Generation (use offset head)
Auto Generate White Fill
Auto Generate Full White Page
Auto Generate White Image

To show the difference between 
the 5 print strategies, a file was 
designed in Adobe Illustrator CS2 
using a Spot White in the logo, the 
outline text ‘FORUM’ and the text 
‘snowboarding’. The file was print-
ed with the 5 different printstrate-
gies onto a red banner media.

No Auto Generation (use in-line head).
This can be used for spot colors and multichannel files. This 
uses the white print head that is in-line with the other print 
heads (head n° 7). You will have to pinpoint the white selec-
tion in your image, using the “spot color replacement” tool (see 
2.4). If you choose this setting, the white ink can not be printed 
on top or underneath another color. If it would be possible, you 
will see coalescence occur. The white ink is not cured before 
the colored ink is placed on top of it so the inks will be mixed 
and the result will look very dull.
(imaging configuration : xxx_White as Spot)

No Auto Generation (use offset head).
This can be used for spot colors, and multi-channel files. This 
uses the leading white print head (head n°8). The generation 
of the white ink separation will be done by selecting the white 
area via the “spot color replacement” tool (see 2.4). This set-
ting will print white ink next to the other colors. If you want 
to print white underneath other colors, you have to select an 
auto-generate option. 
The result will be the same as ‘No Auto Generation (use ine-
head)’ strategy, but it will be printed with the other white print 
head.

Auto Generate White Fill.
White is printed at any point where no other color is being 
printed. The Wasatch SoftRIP will use the pixel info of the im-
age to determine where white ink has to be printed. Pixels 
containing color information with cmyk values of 0,0,0,0, will 
be printed with white ink. When one of the color values is 1 or 
bigger (e.g. cmyk 0,1,0,0), the Wasatch SoftRIP will not gener-
ate any white. So the :Anapurna engine will only print white 
on places where there is “zero pixel info”, using the in-line 
print head (head n°7).


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As you can see in the example above, the background color of the image is a 
mix of white dots and colored dots. The Wasatch SoftRIP will calculate the use 
of the white ink on raster level. So if you’re not using a full tone (100%) in your 
image, the Wasatch SoftRIP will start generating white dots in between the ras-
ter points. 
(imaging configuration : xxx_White Fill on NO Color)

Auto Generate Full White Page.
Generates a white rectangle for the whole 
ripped page size. When the Wasatch SoftRIP 
has finished ripping your image (with or without 
layout), there will be a white separation gener-
ated with the same dimensions as the bounding 
box of your file. So if your image has, f.e. round 
corners, the white area will not be the same as 
the edges of your image.

If you place  two images beside each other in the layout window for e.g. dual 
board printing, the Wasatch SoftRIP will generate a white selection behind the 
complete layout. Be aware that the :Anapurna engine will also print white ink 
between the two images, probably onto your conveyor belt. So don’t forget to 
mask the areas of your conveyor belt between the two substrates.

When selecting the “auto generate full white page” mode, the spread option 
will become active. Choosing a 1/8 inch spread applies a white spread in the 
margin or nesting gap of the page size. This 1/8 inch spread is only intended to 
work on jobs sent through the “Manual Print Layout”.
(imaging configuration : xxx_White Behind Entire Page)

Auto-Generation White Image.
White is placed underneath every non-zero pixel. White ink 
will only be printed underneath the pixels containing color 
information. Areas that are defined as white (cmyk 0,0,0,0), 
will be left transparent.

When you select this option, the drop down menu of the 
choke and spread option will be enabled. Choke and Spread 
allow you to control how the white ink is laid down around 
the edges in the image. The choke option will retract the 

white selection underneath the image. So if you’ve printed your image with the 
“no choke/spread” option and there is a little white border coming out under-
neath your image, you can adjust this using the choke option. Choke ‘erodes’ 
the white from the edges.

Selecting the spread option, 
will result in the opposite be-
havior of the white ink. Instead 
of reducing the white ink area, 
it will increase the dimension 
of the white ink separation. 
A white border will come out 
underneath the image. Spread 
expands the white over the 
edges.

You can choose between differ-
ent intensities for the choke or 
spread option (small, medium 
or large).
(imaging configuration : xxx_White Behind Image)

b.	 Color Transforms.
Launch the Color Transforms screen by clicking on the Color Transforms button. This 
screen provides total workflow control for color management (see 7.1).

c.	 Special Colors.
Launch the Special Colors screen by clicking the Special Colors button. This suite of 
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utilities includes Spot Color Replacement, the Color Database, Spot Color Capture 
and other features described in the Special Colors section (see 6.2).

d.	 Edit Info.
The Edit Info button launches your default text editor (in this case the Notepad win-
dow). Use this feature to create and save records of changes made in this screen .

e.	 Lock.
See 8.4

6.3	Saving a new imaging configuration.
Whenever you make changes to any setting that affects an Imaging Configuration, cre-
ate a new Imaging Configuration by saving it under a new name. This includes changes 
made in the (Properties) control panels, and changes to settings made in other screens 
launched from Imaging Configurations (Color Transforms, Special Colors). When a 
change is made to any of these controls, you must exit the screen using the OK button. 
Changes will be lost if you exit using Cancel.
When you exit using the OK button, the Imaging Configuration - Save As screen is 
launched. The name of the current Imaging Configuration is shown in the top window 
of this screen; previous Imaging Configuration names are shown in the larger window. 
In the Save As window, enter the new Imaging Configuration name. Click on OK to save 
the new Imaging Configuration name and settings.
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7.	Color Menu.
The ‘Color’ menu provides access to most SoftRIP color functions. 
Selecting Correction Curves launches the Correction Curves window, which allows changes to 
image lightness and hue adjustments for individual jobs.

If you choose the ‘Special Colors’ option, you get 
access to the Special Colors screen, to the Spot Col-
or Replacement toolset, Spot Color Capture and the 
Color Database utility.

The System Default ICC Profiles will let you define 
the SoftRIP’s default input and monitor profiles.

In the standard mode, the Wasatch SoftRIP will al-
ways display color values on a scale of 0 to 255. By 
checking the ‘Show Color as Percentage’ mode, will 
change the read-outs to percentage values.

Color Database: Launches the Color Database menu, 
which allows you to choose and edit an existing col-
or database, or create a new one.

Profile View: The 3D profile viewer helps you visualize your available range of colors in 3D CIE 
L*a*b* color space, seeing which colors can be reached, and which will be “mapped” by your 
ICC profiles. It even provides an indication of the shape of the mapping that will be performed 
by your ICC profiles.

The Color Atlas Generator allows you to create a PostScript file of a set of color patches. This 
file can then be printed on any fabric or media, allowing customers to choose colors based on 
how they print on actual materials, rather than choosing from a swatchbook printed on paper. 
Once a color has been selected, it can be reliably reproduced by simply entering the same 
RGB value for that color into SoftRIP or your graphics application. Assuming that the imag-
ing configuration and front-panel printer settings remain the same as those used to print the 
samples, the color output of the printer should match the previously printed color patch.

7.1	The Correction Curves Window.
Color correction curves are used to make adjustments 
to image lightness/darkness and also to specific 
color channels (hues). It is generally used to “tweak” 
individual jobs, but can also be used to make adjust-
ments to specific incoming data on the Color Trans-
forms screen. When you make a color correction, you 
also create a new Imaging Configuration.

Color Correction is performed using the Correction 
Curves window. This widow is launched from the 
main Color menu. It can also be launched by right-
clicking on the job image and selecting it from the 
pop up menu.

a.	 Color correction basics.
Menu Components.
Image Data Type : The Correction Curves area of the menu allows you to select 
the type of incoming data that will be affected by curves adjustments. When 
correcting an image, you may select any or all of the four input data categories 
shown (RGB Vector, RGB Raster, CMYK Vector, CMYK Raster). The changes you 
make in the curves will be applied to those categories checked.

Colorant (Channel) Selection : The curves editor can be used for two basic func-
tions, as follows:

All Channels : Checking this radio button allows you to lighten or darken the 
overall image by moving the curve up or down.

Single Channel : Checking any one of the individual colorant (or color chan-
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nel) radio buttons means that your curve moves will affect only that channel. 
This option allows you to make changes specific hues.

b.	 Editing Model.
When using the curves, you have your choice of curve editing models: Light or Dot 
%. This model is selected above the curves window on the menu. For the sake of 
simplicity, the discussion below refers to the Light model. Choosing the Dot % mod-
el causes the curves to behave in the opposite way as described below.

The horizontal axis of the interface (left to right) represents Input values, which are 
the values of the original image as opened in SoftRIP.  The vertical axis of the inter-
face (bottom to top) represents Output values, which are the new values you set. 
Using the Light editing model, the lower left corner of the box is where both Input 
and Output values are 0% and represents total black. The upper right corner of the 
box is where both Input and Output values are 100% and represents white (in other 
words, the “white” of the media when no ink has been printed). The opposite is true 
when using the Dot % model.

Lower numeric values indicate higher densities and higher numeric values indicate 
lower densities (Light model). Simply speaking, for all channel corrections using 
the Light model, lower values mean darkening the image and higher numeric val-
ues mean lightening the image. For single channel color corrections, lower values 
mean increasing the density (amount) of the specific color (channel) selected, and 
higher values mean decreasing the density of the specific color (channel) selected. 
Remember that no action taken in a digital color workflow happens in isolation.

Control points: Prior to editing, the spline curve in the box is a diagonal line running 
from the bottom left to the upper right of the grid. Control points may be selected 
at any point along this line and dragged in any direction. You may select as many 
control points along the curve as you think are useful. Dragging a point up or down 
lowers or raises output density at that point. The Input and Output values are dis-
played for the point represented by your current cursor position.

Because the tone range is a continuum, whatever moves you make at one control 
point affect the shape of the rest of the curve, and consequently, the values at all 
points along the curve. The advantage of the Curves tool is that you are able to fine-
tune a curve shape to affect specific portions of the tone range.

c.	 Other features on the curves menu.
Clear : Returns the curve in the window to 
its linear position.

Clear All : Returns curves for all colorant 
channels to their linear position.

Curves : Launches a menu of pre-configured 
curves to achieve common affects.

d.	 Saving Your Color Corrections as New 
Imaging Configurations.
The process of color correction changes the 
color properties of individual images (jobs) and 
also specific input data channels on the Color 
Transforms screen. When you make color corrections using the Correction Curves 
menu, you will also be creating a new Imaging Configuration that includes your 
new curves. The new Imaging Configuration can be used with that job or any other 
job for which that Imaging Configuration is selected. When successful color correc-
tions are made, it is essential that you save a new Imaging Configuration.

To save your correction curves, make sure to exit the Correction Curves menu with 
the OK button. If you use Cancel, your corrections will be lost. When you press OK, 
the Imaging Configuration - Save As menu will launch. The name of the current Im-
aging Configuration is shown in the top window of this menu, while previously gen-
erated Imaging Configuration names are shown in the larger window. In the Save As 
window at the bottom of the menu, enter the new Imaging Configuration name. You 
must exit this menu by clicking OK to save the new Imaging Configuration name 
and settings.


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e.	 More on editing curves.
In general, the Curves tools allow you to control the density (amount) of ink output 
by the printer at any or all points along the tone range of the image. If you are work-
ing in All Channels mode, you are adjusting all of the output channels at the same 
time. If you are in Single Channel mode, you are adjusting only that color channel.

Here are a few examples of curves:

Basic Color Correction with the Correction Curves Tool.
There are a few very simple things that can be done in a service bureau operation 
to produce pleasing color for a variety of customers in a quick and cost-effective 
way. By using these basic “tone-curve” methods in conjunction with appropriate 
color profiles, you can produce pleasing color from a wide variety of input.

A valuable tip!
If you need to do quite a bit of correcting with these curves, concentrate 
on getting as close as you can by strictly using the All Channels Correction 
curve. You’ll find that you can get very close indeed and that this is, in fact, 
the only way you can keep everything straight. Only after you’ve done this, 
should you make small hue adjustments with the individual color curves. 

Here is another valuable tip to keep in mind when you use the color correc-
tion curves to adjust hue. If you find that you need to modify one channel a 
great deal to achieve the desired result, it will probably be better if you mo-
dify that one channel less, while modifying each of the other two channels 
in the opposite direction. This will maximize your hue shift, while minimizing 
the shift to overall lightness. The interactive color preview on the screen can 
make this quite clear. It is important to use the Correction curves instead of 
the Calibration curves for this purpose. 

The single most common cause of “muddy” prints is poor selection of the 
black point and white point in the original scans. With a page containing a 
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scan open on the SoftRIP screen, move your cursor over one of the lightest 
highlights. The RGB entry on the information window should show at least 
one number that is over 90%. If not, you are going to see muddy highlights 
and colors. Move the cursor over one of the darkest shadows. The RGB entry 
should show at least one number that is under 10%. If not, your prints are 
likely to have muddy shadows. The same principle applies to CMYK scans.
 
If you’ve been given the job of making a nice looking print from a scan with 
poorly chosen black and white points, there is still something you can do. 
Make a note of the lowest R, G, or B that you can find in a shadow and of 
the highest that you can find in a highlight. In a muddy scan, these numbers 
might be something like 15% and 80%, instead of the 5% and 95% that you 
would hope to see in a good scan.

Select Correction and All Channels.
We will use the Lightness editing mode in 
this example. In the Lightness edi-ting mode, 
black is in the lower left corner and white is 
in the upper right corner for both RGB and 
CMYK curves. Moving a point upward has a 
lightening effect for both CMYK and RGB im-
ages when using the Lightness editing mode.  
Click on the  upper right end of the diagonal 
line and slide it left until the window looks 
like the following:

Now your highlights that had only reached 
80% in the original will be stretched to 
reach 100%, or the density of the base 
media with no ink applied, in the final 
print.

Click on the lower left end of the diagonal 
line and slide it right until you see this:

Now you’ve stretched your shadows from 
15% down to 0%, which will cause them to 
reach all the way to the maximum density 
available with the media and ink that you are 
using. 

Perhaps you’ve done this, and your shadows 
are now nice and dark and your highlights are 
nice and bright, but the overall density of the 
picture, of the midtones, is too dark. Click on 
a point in the center of the diagonal line and 
slide it upward until it looks something like 
this: 

You’ve now lightened the 50% midtone 
by 25% to 75%, while leaving the high-
lights and shadows where you set them 
earlier. This is the most common kind of 
tone correction needed for faulty scans.


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7.2	Special Colors Screen (Spot color management).
Launch the Special Colors screen from the main Color menu. The 
following features are found on or accessed from the Special Co-
lors, Spot Color Replacement menu:

Spot Color Replacement, provides precision control over spot 
or custom colors

Paper Color Controls, allow simulation of paper or media 
background characteristics

This screen also provides access to the Color Database and the Spot 
Color Capture feature.

a.	 Spot Color Replacement Toolset.
The Spot Color Replacement toolset provides precise controls for spot color printing. 
Spot colors can be tweaked to correct errors in incoming files, changed to reflect 

ne w requirements, and used to bypass 
color management altogether by di-
recting output to individual print heads 
containing custom formulated ink.

In the ‘Spot Color Replacement’ area of 
the Special Colors window select the 
type of images you wish to affect: Vec-
tor Graphics Only, or both Vector and 
Raster Graphics. Checking the Vector 
Graphics Only radio button ensures that 
spot colors (such as corporate logos) are 
individually color managed with no fear 
of corrupting embedded photographs 
(raster graphics).
Checking Vector and Raster Graphics 
allows you to manipulate the indexed 
TIFF files common in digital fabric and 
textile design.

There are two ways to select spot colors from an open preview image:

When an indexed, or limited-color image is previewed, use the Add Indexed 
Colors button on the Special Colors screen to read these colors into the window. 
After a pause, you will be asked if you wish to add the colors to the list. This is a 
quick way to make entries to the Spot Color Replacement window.

The window on the Special Colors screen shows information in 
three columns. The Color Value column shows the original color 
and its color values. All colors are specified using the 0 – 255 
range, whatever color space they are in. If no replacement color 
has been specified, the color square to the left is a solid block. 
If a replacement color has been specified, the color block is 
split. The left side shows the original color and right half shows 
the replacement color.

The Replacement column shows the values of the replacement color. If no re-
placement color has been specified, the values are the same as those in the 
left hand (Color Value) column.  In order to specify a replacement color, double-
click on the original color in the left hand column. This launches the Spot Color 
Replacement screen. The operation of this screen is explained in more detail 
below.

The other method for making an entry to the spot color replacement list (on the 
Special Colors screen) is to right-click on any location in a previewed image, 
launching a pop-up menu. The “color to be replaced” can be “CMYK”, “RGB”, or 
“Gray”.

Selecting Replace Spot Color from the pop-up menu launches the Spot Color 
Replacement screen, as well as the Special Colors screen if not already open. 
The Replace Spot Color window may also be launched by double-clicking on any 
color in the Special Colors window, as previously noted. 











Stay ahead. With Agfa Global Services.	 Wasatch SoftRIP AE 6.0

Color Menu	3 1

Spot color replacements can be defined using “named” colors 
within the application software that drives Wasatch SoftRIP. This 
leads to some attractive workflow options. When right-clicking on 
a “named” spot color, Wasatch SoftRIP allows the definition of a 
replacement that will be applied to all colors bearing that name. 
For example, the name “White” can be assigned to a print head 

that contains white ink, and then the use of this 
print head can be directly specified by the graphic 
artist running the application software. The “tint”, 
or “percentage” specifications made in the applica-
tion software are applied to the replacement color, 
allowing such things as a “white gradient” to be 
produced by the artist. (“Tint” information only ap-
plies to CMYK and Device color, not to Lab or RGB 
color.) Enter the values of the replacement color di-
rectly into the windows in the Replacement Color 
area. You may change the Replacement Color space 
to “RGB”, “CMYK”, “CIE Lab” or “Device” before 
you enter new values.

Access the Database button in order to retrieve an existing color previously 
placed in a Color Database (more later). Name and save either the original or the 
replacement color using the Add to Database button.

Choosing “RGB” or “CIE Lab” as the replacement color space, 
causes a CIELab / sRGB button to appear on the Replacement 
Color screen. This button launches the CIE Illuminant window.

Colors chosen in this window may be specified in several different color spaces. 
After specifying a color, click OK to add it to the Replacement Color area of the 
Spot Color Replacement screen. From this window, you may also access Spot 
Color Capture, which allows you to record colors directly into the Color Data-
base from any color sample or surface using a colorimeter. These colors may 
then be modified in the Spot Color Replacement screen. Selecting Device as the 
replacement color space changes the entry in the Type column of the Special 
Colors window from “In” to “Out”. 

An “In” listing in this column means the color 
preview on the screen accurately displays the ex-
pected output color.

Also, when Device is selected, the replacement 
color displays as a red hashmark in the selected 
image area, in the Replacement Color area on the 
Spot Color Replacement screen and in the Color 
Value column in the Special Colors screen.

Using the Device replacement option bypasses 
all color management, enabling you to directly 
specify ink densities for individual print heads. 
Use this feature for metallic inks, varnishes, or 
specially mixed “corporate color” inks.

The Paper Color area of the Special Colors screen allows you to simulate paper 
characteristics, and is useful for making the paper itself match a particular proof-
ing “white point”. This feature is used along with an Absolute Colorimetric render-
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ing intent to produce color match proofs for “off 
white” papers. To produce match proof simula-
tions of a CMYK device, select your ICC Imaging 
Configurations in the Color Transforms menu and 
check Print CMYK White Point on Paper.

7.3	Using the Color Database.
The Color Database is a user-maintained list of named colors. It is 
accessible two ways: directly from the Color menu at the top of 
the Main Screen, or via the buttons on the Spot Color Replacement 
screen.

Color entries in the Color Database 
can be edited or deleted by double-
clicking on the color name. They can 
also be selected as replacements 
for spot colors specified in the Spot 
Color Replacement screen.

Colors may be entered into the Color 
Database several ways. Selecting 
Color Database from the Color menu 
opens the Color Database screen. An 
existing database may be selected, 
or a new database may be created 
by clicking the Create A Database 
button. When a new database name 

is entered, a new window launches. Pressing the Create New 
Entry button launches the Color Mixer interface.

Color values may be entered in any of the windows on this 
screen. This screen also provides access to the CIE Illuminant 
window. Color may also be selected by clicking and dragging 
on the “Saturation/Brightness” square or the “Hue Bar” next 
to it.

Colors entered here are stored as ‘sRGB’ data, and reproduce 
accurately when used with an Imaging Configuration built 
with “sRGB” as the incoming RGB data profile. sRGB is the 
“gold standard” profile, published by Hewlett-Packard on the 

internet at www.srgb.com, and also found on Windows XP and 2000 systems in a sys-
tem folder, with the name: sRGB Color Space Profile.icm.

a.	 Spot Color Capture.
Spot Color Capture allows you to directly record custom spot colors from a swatch-
book or other type of color sample…simply by clicking on it with your handheld col-
orimeter. This process is initiated by clicking on the Spot Color Capture button on 
the CIE Illuminant menu. This will launch the appropriate wizard for the colorimeter 
you select. Once the color is read in, the CIE Lab values are entered automatically in 
SoftRIP’s Color Database utility.
When you are ready to print, the CIE Lab values in your Color Database are sent 
directly to the ICC color profile for your output device. This streamlined approach 
bypasses the confusion and loss of accuracy that can result from managing input 
profiles. The accuracy of your spot color matches will be determined by the quality 
of the ICC device profile.
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8.	Color Management Tools.

8.1	Color Transforms Screen.
The Color Transforms screen is launched by pressing the Color Transforms button on the 
Imaging Configurations screen (Print menu -> Setup -> Edit -> Color Transforms).

Overview: Transforms screen provides ICC 
profile-based color management across the 
entire production workflow. The features on 
this screen allow you to create and apply cor-
rection curves for incoming files and select 
custom ICC profiles for both incoming data 
and output devices. Whenever you make 
changes to your color settings, the flowchart 
on the Color Transforms screen dynamically 
changes to visually describe the processing 
that will take place.

Also on this screen are the controls for Half-
tone Methods, access to the Calibration util-
ity, access to Color Separation Rules and ad-
ditional controls for Ink Limiting.

a.	 ICC Workflow Features.
Incoming data is divided into four classes: RGB Vector, RGB Raster, CMYK Vector & 
CMYK Raster. Separate correction curves, ICC input profiles and rendering intents 
can be specified for any or all of these categories, as described below.

b.	 Color Corrections.
Clicking the ‘Correction Curves’ 
icon next to any of the four in-
put categories will launch the 
Color Corrections window. This 
window is the same as the one 
launched from the main Color 
menu at the top of the Main 
Screen, except that the type of 
input is already specified in the 
Correction Curves area. Adjust-
ments to overall lightness and 
darkness (all channels) or indi-
vidual hue channels are made 
using this tool. A more detailed 
description is found in the Color 
Corrections section of this doc-
ument (see 6.1).

c.	 Replacing ICC Input Profiles.
You may provide custom input profiles for any of the four incoming file cate-
gories. This feature is located in the ICC Input Profiles area of the Color Trans-
forms screen. For each input category, the profile in use is displayed at the 
top of the control area. This may be a default profile shipped with SoftRIP, or a 
custom profile provided by you. Changing input profiles is a very powerful tool 
and can have a significant affect on image quality.

To load a new profile, press the Select button. From the new window, select 
Browse to access your hard drive and load a new custom profile. You may also 
select None, for no profile, or choose the System Default profile.

Pressing the View button next to the Select button launches the Profile View 
feature, which displays a 3D model for the color space you have selected. You 
can select a Rendering Intent for the new ICC profile by using the drop down 
window in the ICC profile control for each input category.
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Changing ICC Output Profiles : The output profile describes the color space of the 
printing scenario, including the printer, inkset, media, configuration, calibration, 
and other settings. Custom Output Profiles can be loaded using a control similar to 
those for the input profiles. Load a new ICC Output Profile by pressing the Select 
button under the ICC Output Profile header. This will allow you to access whatever 
custom profiles you have stored on your hard drive. The View button launches the 
Profile View as in the ICC Input Profile controls described above.

d.	 Other Controls.
Color Separation Rules (not used with the :Anapurna).
This powerful control is most commonly used to allow Hi-Fi color devices with 
ink sets such as CMYK plus Orange, Green, Red, Blue or other ink colors to be 
profiled as RGB or CMYK devices. It is also very useful for intelligent ink limit-
ing. On the Color Transforms screen, the Color Separation Rules button is ac-
tivated by checking the Use Color Separation Rule box in the upper left of the 
menu. When you check this box, you will see changes in the flowchart arrow in 
the ICC workflow areas of the menu. When you click on the Color Separation 
Rule button, the Color Separation window is launched.

Calibration (not used with the :Anapurna).
This button launches the Calibration window, which allows you to improve sys-
tem performance by linearizing the printer and print condition. This process is 
described in the Calibration section of this document.

Ink Limiting controls.
This control establishes a maximum that the total ink may not exceed. On a 
CMYK printer, the highest available setting will be 400%, (which corresponds 
to no limit at all). Setting a limit in the range of 150% to 350% can prevent 
ink acceptance problems on many media. Settings above 200% will typically 
improve ink acceptance problems without significantly reducing color gamut. 
While SoftRIP will allow setting below 100% (with 50% the minimum), settings 
under 150% should be used with great caution.

Use Embedded ICC Profiles.
When this box is checked, SoftRIP will apply any embedded ICC profiles found 
in the four input data categories instead of the selected Input Profile.

Selecting Halftone Method.
This dropdown window allows you to change the Halftone Method applied to 
the Imaging Configuration. Additional controls are launched for most Halftone 
Methods by pressing the Halftone Properties button beneath the dropdown win-
dow.

Saving new imaging configurations. 
Remember that when you make any changes to the settings shown on the 
Color Transforms screen (including correction curves), you must save these 
changes as a new (re-named) Imaging Configuration. In order to accomplish 
this, you must exit the Color Transforms menu by pressing the OK button. 
When you exit the Color Transforms menu, you will be in the Imaging Con-
figurations menu. You must then exit Imaging Configurations with the OK 
button as well, or you will lose your changes.

When you exit the Imaging Configurations screen, the Imaging Configura-
tions - Save As menu will be launched. The workings of this menu are de-
scribed in more detail in the Imaging Configurations section of this docu-
ment.

8.2	The Importance of Input Profiles.
When using ICC color workflows, an accurate device profile of your printer, inks, and 
paper is essential, but it is only half the battle. Color is also controlled by your choice 
of ICC input profile, which determines what color device will be ‘simulated’ by your 
prints. This is more than just a matter of “fine tuning”. Choosing the wrong input profile 
can cause your color to be wrong by many delta E. If you don’t control your input pro-
files, it simply doesn’t matter how well you’ve profiled your output devices.


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The next illustration uses the Profile View feature of Wasatch SoftRIP to compare the 
3D color gamut of an “Adobe RGB” color profile to an “sRGB” color profile (which is 
nearly identical to the gamut of an “Apple RGB” profile). 

In this illustration,  the Adobe RGB 
profile’s color gamut has been ren-
dered as a cloud of colored dots, 
while the sRGB profile has been 
rendered as a gray “gamut boun-
dary”. This is done to illustrate that 
the colors available in the Adobe 
RGB color gamut extend far beyond 
those available in the sRGB gamut. 
(The difference in green, for exam-
ple, is over 20 delta E.)

If a photograph taken in Adobe 
RGB color space is printed with an 
sRGB (or Apple RGB) input profile, 
colors will be substantially reduced 
in saturation, or “muted”. Likewise 
a photograph taken in sRGB space 
and printed with an Adobe RGB in-
put profile will be oversaturated, 
and the print will contain color er-
rors of over 20 delta E. These errors 
will exist even if your output profile 
is “perfect”.

The profiles used, are selectable standard working spaces in Adobe Photoshop and can 
also be downloaded from Adobe and sRGB web sites. Any user of Wasatch SoftRIP can 
download these profiles and use Profile View to study the issue further. Another com-
mon problem is the fundamental conflict between accurately modeling ANSI SWOP 
CMYK color, and printing beautifully high contrast pictures.

The gamut hull shown on the left side, is from an industry stan-
dard accurate profile of SWOP printing, a profile that is often used 
for ICC managed color proofing. When combined with an accurate 
output profile (and repeatable ink and paper), it turns your inkjet 
printer into a highly-standardized color proofing system.

Note, however, that the gamut hull never touches bottom in this 
illustration - it never reaches the black point. Any accurate profile 
of SWOP printing won’t visit any point darker than an L value of 
about 7.8%. Because no black darker than 7.8% can ever be speci-
fied through the input profile, prints made this way often exhibit 
“dusty blacks”, and never show the full brilliance possible with 
inkjet printing. When beautiful prints are preferred to accurate 
proofs, a profile such as 
the “Approximation with 
stretched L”, shown in the 
next illustration, will pro-
duce better results. (Both 

these ICC profiles are included with Wasatch 
SoftRIP.)

There are dozens of different input color spaces 
in common use as ICC profiles, and the input 
profiles included with Wasatch SoftRIP are noth-
ing more than typical ‘generic’ defaults. Whether 
or not you get good out-of-box color depends 
on how well these ‘generic’ profiles match your 
needs. If they don’t, Wasatch SoftRIP makes it 
easy for you to set up whatever you need, and 
Wasatch Profile View is a powerful tool for anal-
ysis of what’s happening. 
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a.	 Changing System Default ICC Profiles.
The stock Imaging Configurations used by Wasatch SoftRIP do not con-
tain input profiles. Rather, they refer to the default input profiles which 
are contained in the /wwrip/DefaultColorSources folder on your hard 
drive. These input profiles control: Display monitor, RGB input data & 
CMYK input data.

A full discussion of input profiles and how to change them for specif-
ic jobs will be found in the Color Transforms section of this document. 
The objective of the discussion below is to show advanced users how to 
change the system defaults.

b.	 Changing System Default Input Profiles.
Select System Default ICC Profiles from the Color menu to launch the ‘System De-
fault ICC profiles’ screen. The bottom two windows on this screen allow you to 
browse your files in order to select ICC profiles for RGB and CMYK input data.

The top window, labeled Monitor Profile, al-
lows you to import a custom monitor profile. 
This profile will control your display, instead 
of the generic default profile shipped by Wa-
satch. Selection of the proper ICC profile will 
allow you to “softproof”, which refers to the 
process of bringing your monitor screen as 
close as possible to a representation of the 
final output.

Substitution of your own input profiles will match all of Wasatch’s Imaging Configu-
rations to the behavior you’re looking for in your workflow, whether that is a par-
ticular SWOP proofing behavior, the RGB space used by a particular digital camera 
or scanner, or anything else you wish. This behavior is controlled by the new input 
profiles you have selected.

Remember: Changing the default profiles in this menu will change the color be-
havior on every job (unless you change the individual input profiles for that job on 
the Color Transforms screen). It is easy to return to Wasatch’s default input profiles 
by clicking on the Restore Wasatch Defaults button in the upper left of the System 
Default ICC Profiles screen.

monitors are also limited in gamut, producing accurate reproductions of screen dis-
plays, but prints that are less bright than is possible. Small adjustments to this type 
of profile can produce far greater density ranges and more-pleasing pictures.

c.	 Out-of-Box Color.
When using ICC workflows, an accurate device profile of your printer, inks, and pa-
per is essential, but it is only half the battle. Color is also controlled by your choice 
of ICC input profile, which determines what color device will be ‘simulated’ by your 
prints. This can be a profile of your monitor, a SWOP proofing system, a particular 
digital camera or scanner, or of anything else whose color you would like to match.

Different input profiles are key to achieving different goals in color reproduction. 
For example, a profile of a SWOP proofing, such as the default CMYK input profile 
shipped with Wasatch SoftRIP, will accurately reproduce process colors, but it can 
produce “dusty” looking blacks on most inkjet printers. Accurate profiles of display 
monitors are also limited in gamut, producing accurate reproductions of screen dis-
plays, but prints that are less bright than is possible. Small adjustments to this type 
of profile can produce far greater density ranges and more-pleasing pictures.

d.	 ICC Rendering Intent.
Different devices have different ranges of possible colors (differ-
ent “color gamuts”), and often have different paper colors or “white 
points”. This creates special problems for color matching. The four 
rendering intents defined by the ICC are essentially “matching styles” 
that address these issues in different ways.  
When new input ICC profiles are selected in the Color Transforms 
menu, Wasatch SoftRIP defaults to the ‘Perceptual’ rendering intent. 
This default will be appropriate for most users, but for those with more 
demanding requirements, other rendering intents can be chosen in 
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the individual controls for each category of incoming data.

The following describes the four rendering intents defined by the ICC, along with 
defaults and recommendations for use within Wasatch SoftRIP.

Perceptual.
This rendering intent maps color “smoothly”, preserving relationships between 
similar colors. This prevents gamut clipping with its potential loss of detail and 
tonal banding problems. Gamut clipping occurs when colors that are different 
in the input image appear the same when printed. Perceptual rendering intent 
makes small compromises throughout the entire color space in order to preserve 
color relationships. It sacrifices some precision of in-gamut colors in order to en-
sure pleasing results. Perceptual intent will produce the most predictable results 
when printing from a wide range of image sources, for example, when printing 
RGB images on CMYK devices, or when trying to match CMYK devices that are 
radically different from each other. We consider this “foolproof” setting to be 
best for users who handle the wide variety of images that commonly enter large 
format printing facilities. It is usually not precise enough for processes where 
input images are well controlled, such as color proofing and giclee. Perceptual 
rendering intent is the setting of the default color configurations shipped by 
Wasatch.

Absolute Colorimetric.
When a color is not printable within the gamut of the output device, this render-
ing intent simply prints the closest match. It reproduces in-gamut colors without 
compromise, as faithfully as possible. This produces the most accurate match-
ing of spot colors. Unfortunately, it can also result in gamut clipping where two 
colors that are different in the original are identical on the print. White points 
may also be clipped, interfering with highlights in images. Such clipping, and 
the resultant problems, makes this choice most suitable for work involving spot 
colors, or for work where it is desired to print on a bright-white paper to simu-
late an off-color paper. Although Wasatch SoftRIP never sets it as default, you 
can choose it from Wasatch SoftRIP’s user interface.

Relative Colorimetric.
When a color is not printable within the gamut of the output device, this render-
ing intent prints the closest match along with an adjustment that maps white 
to the paper of the output. This mapping of white point prevents the problems 
of Absolute Colorimetric when images (or anything other than spot colors) are 
involved. When producing color match proofs on inkjet printers, which typically 
have larger gamuts than the printing presses being simulated, this is a superior 
choice. When a pair of ICC profiles is loaded for runtime linking, one for the 
device to be simulated and one for the device being used, this rendering intent 
will provide good precision (minimal delta-E) for the match-proof process.

Saturation.
This preserves the saturation, or brightness of colors when transforming them 
for output. It maps fully saturated source colors to fully saturated target colors. 
This rendering intent is used where color matching and exact relationships be-
tween colors is less important than bright colors. This is a “pretty picture” intent 
that will produce brilliant spot colors, and although Wasatch SoftRIP never sets 
it as default, you can choose it from Wasatch SoftRIP’s user interface.

8.3	Profile View.
Wasatch SoftRIP implements the ICC profile standard for color management. This 
means that color is controlled by your color profiles and profiling software, not by your 
RIP. Wasatch profile view will help you to avoid letting your color profiles become an 
out-of-control “black box”.

Wasatch provides powerful tools to enable you to import profiles and match color to 
within all the precision available from your color instruments and profiling software. 
Even so, not all color simulations are possible, and sophisticated users are familiar with 
the phrase “out of gamut”. Many problems with color can be understood by visualiza-
tion of the color gamut of your printer, and of the color spaces you’re trying to match. 
The 3D profile viewer helps you visualize your available range of colors in 3D CIE L*a*b* 
color space, seeing which colors can be reached, and which will be “mapped” by your 


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ICC profiles. It even provides an indication of the shape of the mapping that will be 
performed by your ICC profiles.

It lets you display three-dimensional, animated, plots of the color gamuts contained in 
your ICC profiles, allowing you to view two different gamuts at the same time for com-
parison. You can put a gray wrapper around one  while viewing the colors of the other, 
to see exactly what’s out of gamut. You can click directly on the image to spin it just 
like a video game, for a complete view and visualization of the relationship.

The Profile Viewer can be launched from the main Color menu of Wa-
satch SoftRIP. The animated view window displays the color gamut in-
formation with your choice of either ‘ICC-absolute’ or ‘Media relative’ 3D 
CIE L*a*b space. You can click and drag the animated view to position 
it for any view you’d like. Right click if you want to change the speed 
of the animation, and to increase or decrease the size of the 3D data 
display.

The illustration on the left, shows a 
‘typical’ RGB monitor profile as input 
profile with color points displayed, 
overlaid on a ‘typical SWOP’ CMYK 
output profile displayed as a ‘gamut 
shell’. Note the display of ‘Gamut 
Volume’. With an RGB input profile 
whose gamut volume is twice that of 
the CMYK output profile, we’re able 
to confirm that fully half of the colors 
viewable on this monitor will undergo 
gamut mapping during printing. This 
is a fairly typical situation that is valu-
able to understand.
 
The display is in either ‘ICC-Absolute’ 
or ‘Media Relative’ colorimetric space. 
The ICC display shows Lab values rela-

tive to a ‘perfect diffuser’ or ‘perfect white’, while the ‘Media Relative choice shows 
Lab numbers scaled such that an L of 100 corresponds to the paper. In this mode, the 
maximum L is always 100. These choices correspond to the Lab spaces defined in ICC 
profiles. Maximum saturation shown as an indication of the brightest color. It is the 
maximum distance of the gamut from the gray scale. Finally, gamut volume is shown to 
indicate the total volume of colors that are within gamut.

These windows initially launch with a display of 
your current ICC output profile shown as a gray 
“gamut shell”, and your current RGB input pro-
file shown as colored points. This provides an in-
stant view of all the colors which lie outside of 
the gamut of your current output profile. To view 
other gamut relationships, simply click either of 
the buttons labeled ‘Select Profile’, to launch a 
menu of other selections. The Browse selection 
in particular provides a powerful way of compar-
ing printers, ink sets, devices to be simulated 
(proofing subjects), and other ICC profiles. 

The Profile Viewer can also be launched from two other points within Wasatch SoftRIP. 
They are: Right-click on any color in a preview and The ‘Profile View’ button in the 
Color Mixer (right next to ‘Spot Color Capture’)

When the view is launched by either of these means, a green 3D cross hair is added to 
the display, to indicate the position of the color in relation to the gamut displays. The 
following illustration was produced by clicking on ‘pure’ RGB yellow, and the green 
mark can be seen toward the top of the 3D display, which has been rotated by hand to 
make the mark clearly visible.

Note that this point, which lies at the ‘yellow extreme’ of the RGB input profile, lies 
well outside the gamut shell of the CMYK output profile. This makes it easy to see at a 
glance when colors can’t be achieved by the current output profile.
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a.	 Mapping.
It is common to speak of the four ICC rendering intents as if they are clearly speci-
fied, but the fact is that the ICC is very vague about gamut mapping, indicating that 
details are up to the producer of the ICC profiles. There are a few critical things to 
understand about gamut mapping:

	 Out of gamut colors are	 Gamut mapping with Absolute
	 indicated with an ‘X’	 Colorimetric rendering intent

Gamut mapping is important, as suggested by the illustrations, in which fully 
half of the colors in the input color space will be subjected to mapping during 
printing.

Gamut mapping is completely controlled by your color profile, meaning it is de-
termined by your color profiling software. It is not determined byw the Microsoft 
CMM or by Wasatch SoftRIP. Specification of an ICC rendering intent only se-
lects between different data sets in the ICC profile, nothing more.

Different software packages for color profiling differ widely in how they set up 
gamut mapping, a consequence of the deliberately-vague definitions for render-
ing intents that are provided by the ICC.

The ‘mapping’ button in the Wasatch profile view provides a view of how values 
from throughout Lab space will be remapped by any given rendering intent in your 
color profile.

In the illustrations, the same profile has been selected for both entries, with the 
left illustration showing the gray ‘gamut shell, and the right  illustration showing 
the gamut mapping that will be performed with a ‘Absolute Colorimetric’ rendering 
intent. This provides a nice view of how all out-of-gamut colors will be remapped.
The right illustration, the outer points of the lines represent the color being re-
quested, the inner points of the lines represent where the color will be mapped by 
the ICC profile, while the lines themselves simply connect the points to give some 
indication of the direction of the mapping. Notice how this particular profile tends 
to map out-of-gamut colors along lines that are more horizontal than the line to the 
nearest point in gamut. This tends to increase the accuracy of color lightness at the 
expense of accuracy in color saturation. This is just one of the myriad mappings that 
are possible for any rendering intent, even while staying within the ICC specifica-
tion.

Because the mapping of out-of-gamut colors is so vaguely specified by the ICC, it is 
a fundamental point to consider when comparing ICC profiling software. 






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9.	Other Menu Features.

9.1	Server and Hotfolders.
In conjunction with Wasatch ImageNETTM, the Server feature allows you to automate 
the workflow in even the most complex production environment. You may set up and 
configure any number of “hot folders” and sub-directories for each printer installed on 
SoftRIP. When job files are sent to these directories via ImageNET or other network, 
they are processed according to the “instructions” specified in each directory.
Hot folders can be configured to specify:

Processing action for arriving files (RIP and Print, RIP only, Add to RIP Queue)
File maintenance after RIPing and Printing
Imaging Configuration applied
Rotating, mirroring, scaling

a.	 Setting up and configuring hot folders.
To activate this feature for the current print-
ing unit, launch the Hot Folder screen from 
the Server button at the top of the main 
screen . Click in the Active box to activate 
the controls.

The hot folders you set up will apply to the 
printer unit currently selected in the Unit 
window of the main screen. You may set up 
as many folders and sub-directory levels as 
you wish and specify separate operating pa-
rameters within each one.

Folders and sub-directories are chosen using 
the Browse feature at the bottom of the Hot 
Folder screen. When you choose a folder, Soft-
RIP will automatically include any sub-directo-
ries already in the root folder, creating job hier-
archies that are multiple levels deep.

In the illustration, the root folder “incom-
ing jobs” has been selected from the D: drive. 
Once the other parameters have been set up 
on this and related screens, pressing OK will 
cause SoftRIP to process any job file transmit-
ted to that folder according to the instructions 
specified in the Actions to Take with Arriving 
Files area (Add to RIP Queue, RIP only, RIP and 
Print).

Checking Create Preview Images produces preview thumbnails for entries made to 
the RIP and Print Queues.

b.	 If you want to use the rotate, mirror and scale features, you must 
check the create preview images box.
The Configuration button launches the Configuration screen which lists your folder 
hierarchy for the current print unit. In the window, the Hot Folder column shows the 
structure of your root directory and sub-directories. You may set up as many levels 
as you choose. On the Configuration screen the Imaging Configuration column dis-
plays the Imaging Configuration that will be applied to the incoming job file. In this 
example, the first folder uses the Default Imaging Configuration. The Default means 
whatever Imaging Configuration is currently specified for the Unit.

On the Configuration screen, the Rotate/Mirror/Scale column displays image ad-
justments to be applied to incoming job files. The third listing in the window dis-
plays “0 1 .085” in this column. This indicates a 0 degree rotation, mirroring on and 
a 85% scaling factor.




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c.	 Specifying imaging configurations and image adjustments.
Double-clicking any listing in the Configuration window launches the following 
screen:

Imaging Configurations : If you leave the Use Default Imaging Configuration box 
checked, the folder will apply the Imaging Configuration currently specified for that 
unit. When Default is selected, the Imaging Configuration is shown in the grayed 
out Imaging Configuration window.

You may also override the current selection by unchecking the Default box and 
selecting a new one from the drop down window. Imaging Configurations you have 
previously loaded from the SoftRIP Imaging Configurations CD’s will be available in 
this window.

Image Adjustments : Checking the Apply Transforms box on the screen activates 
the Rotate/Mirror/Scale controls.

You must click OK in order to active changes you make in this screen. When you 
send a job file to the folder or sub-directory, SoftRIP will automatically process the 
job according to the parameters you have set up in these screens.

9.2	Service Data Uploader.
The Wasatch Service Data Uploader is provided to speed the solu-
tion of problems for customers with a current Service Agreement. 

The “Service Data Uploader” is a powerful tool for working quickly 
with Wasatch Customer Service to get your questions answered. It 
enables Wasatch to examine your settings and imaging configura-
tions in detail, and it makes it simple for you to upload problem 
files without needing to deal with email attachments or file com-
pression utilities. 

The general settings of Wasatch SoftRIP, and some details of your system are always 
uploaded. You may additionally request that imaging configurations and ICC profiles 
for your current printer configurations be uploaded. This can save many rounds of ques-
tions and answers when you want a problem solved quickly. 

This tool can also be used to upload prob-
lem files, or to make an instant “snapshot” 
of your Wasatch system’s status for your 
own use or for sending to your dealer, with-
out uploading it to Wasatch. Run Service 
Data Uploader from the main Wasatch Help 
menu. 

The next screen will prompt for your con-
tact information, so that someone can get 
back to you about your problem, and for a 
description of the problem. After complet-
ing all contact information and a problem 
description, press OK to reach the next win-
dow.
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If your problem has anything at all to do with image quality, make sure you check “Full 
Imaging Configurations”. If you’d also like to upload some small (under 20 megabyte) 
problem files, check “Problem Files”, and use the “Add” button. When your selections 
are complete, you can either press “Upload” to immediately send data to Wasatch, or 
you can press “Make File For Upload” to create the data file and place it where you like 
on you system. 

It can be extremely useful to choose “Make File For Upload” if you are not on the inter-
net, or if you simply want to make a “snapshot” of system data for your own use, or for 
later transmission to someone other than the Wasatch service department. The “tar” 
or “Tape Archive” file format created by Service Data Uploader can be opened by most 
common compression/decompression utilities, making it completely accessible to all 
service technicians other than those at Wasatch. This also allows you to review exactly 
what information is being sent to Wasatch, should you have concerns about security. 

If you are running tests on someone else’s computer, as often happens during sales 
calls or at trade shows, attaching a thumb drive and using “Make File For Upload” to 
place data on that thumb drive is a great way to secure the service information for later 
analysis or transmission. 
Any time you upload data to Wasatch, contact our service department via email to let 
them know it’s coming.
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10.	 Top Tabs.
The tabs along the left and upper edges of the main 
window include many of the key file preparation and 
workflow tools in SoftRIP. Based on your top tab se-
lections, tabs along the left of the screen may ap-
pear, disappear, or modify.

10.1	 Job Tab.	
When the Job tab is selected, you can open an individual input file, or job, to be pre-
pared for printing. With the Job tab selected, a full set of options for sizing, cropping, 
scaling, and tiling appear.

10.2	 Layout Tab.

a.	 Working with SoftRIP Layouts.
The Layout tab lets you use the full width of your media as a digital canvas upon 
which you can prepare images to print as part of your complete production run. 
With this workflow, you can easily drag and drop images into the layout, manipu-
late them, and nest them to fit efficiently as part of your overall print run. Both new 
images and pre-RIP’d images can be added to the layout tab for nesting into new 
production layouts. Pre-RIP’d files will not be RIP’d again when submitted for RIP 
processing as part of a new layout.

The key layout tools can be accessed through various methods to suit user prefer-
ences, including main menu options, right click menus, tool bar buttons, and hot 
keys.

b.	 Adding Files to a Layout.
To add an image to a layout, you can click the familiar “file open” 
button on the tool bar, or select Import File from the File menu. You 
can drag and drop one or more files from the File Browser window 
on the left side directly into the layout or select a recently used file 
from the list shown at the bottom of the File menu.

When you add new files to the layout screen, the PostScript Inter-
preter will launch on your task bar to process the preview of the 
file. While this Interpreter is processing, you can cancel the import 
and preview of all jobs by clicking on the “Cancel Preview” button, 
located on the right side of the tool bar. Images can also be added 
to the Layout from other workflow tabs across the top of the main 
screen. To add an image from the Job tab to your layout, select the 
Add to Layout right click menu option or tool bar button.
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To add images from the RIP and Print queues, select the 
job and click on the Add to Layout button. RIP’d files will 
show up with a solid blue outline. RIP’d files cannot be 
resized/rotated/cropped etc unless you choose to re-RIP 
them. Note that only selected jobs can be added to lay-
outs. Layout entries in the Print Queue cannot be added 
to other layouts.

From the Print Queue, you can also click the Layout 
Queued Jobs button to send all copies queued for print 
to the layout screen. Using this option with the Hold for 
Layout option creates workflow similar the to Manual 
Print Layout workflow from previous versions of SoftRIP. 

Note that the Layout Queued Jobs button is only activa-
ted when the selected Print Queue matches the printer 
selected in the Print Unit drop down window at the top 
of the main screen.

c.	 Basics of the Layout Screen.
When working within the layout, move images by clicking on them and dragging 
them to the desired location on the layout. You can select multiple images by drag-
ging a box around the group of images, or by holding down the Control key while 
clicking successive images.

There are two right click menus for working within the layout. 
Clicking on an image with the right mouse button will display 
a menu of options for changing the image size, rotation, mirror, 
position etc. Right clicking on the layout space between images 
will display a menu of options for crea-
ting automatic layouts, aligning or spa-
cing multiple images, and other tools to 
assist in the creation of your layout.

At the top of the layout screen, there is 
a Name field for specifying a name for 
your layout. This name will be displayed 
in the notes field of the print queue 
when the current layout is submitted to 
the queues.

d.	 Preparing Images to Print.
You can prepare images to print with tools like resize, crop, mirror, and tile easily 
with the layout workflow. You can access these tools by right clicking on an image, 
selecting an option from the Image menu, or using the appropriate tool bar button.
If you do not have a file selected, or have selected multiple images you will notice 
that some tool bar buttons and menu options become “grayed out”

e.	 Resizing.
Simple resizing can be done directly inside the layout screen by positioning your 
cursor over the image’s outline and dragging it in or out to achieve your desired 
output size. Select Quick Size from the Image right click menu to enter a scale per-
cent or by entering the image width or height. Note that both of these size options 
will only resize with proportions constrained.

f.	 Cropping and Unconstrained Proportion Resizing.
To crop or resize without proportions constrained, select the Size/Crop menu op-
tion or click on the tool bar Crop button to launch the Image from Layout tab. This 
screen occupies the space of the Job tab, and you will receive a warning message 
that any image previously opened in the Job tab will be closed.

g.	 Rotation and Mirror.
The Rotate and Mirror tools can be used for one image or a group of images. Select 
your image(s) and select from the Rotate Right, Rotate Left, or Mirror menu options. 
Standard tool bar buttons are also available for these functions.
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h.	 Exact Positioning.
To define precise positioning for your image within the layout, select the Position 
menu option or double click on the image. A position entry box will launch for 
specifying the location of the image’s top left edge.

i.	 Tiling.
To tile an image that is too wide for your current printer, select the image and the 
Tile menu option. As with the Crop function above you will launch an Image From 
Layout tab; in this case with the Tile tab enabled on the left. You will be warned 
that any images open in the Job tab will be closed. After entering your tile configu-
rations select the tiles to add to your layout and click the Update Layout button.

j.	 Changing Image Quantities.
The Duplicate menu option will increase the copies of an image by one copy, where-
as the Add Copies menu option will allow you to enter a specific number of copies 
to add. Note that identical instances of an image within a layout will only be ripped 
once. Duplicates that are then resized, rotated, or otherwise manipulated will need 
to be RIP’d separately.

To remove a copy of an image from the layout, select the image and click the delete 
button on the toolbar or press the delete key on your keyboard. To clear an entire 
layout, select Clear Layout from the File menu, or click on the “close” tool bar but-
ton while the Layout tab is active.

k.	 Preparing Efficient Layouts to Print.
SoftRIP provides you with a range of tools for creating easy automated or custo-
mized layouts. You can access layout design tools by right clicking on the open 
space between images on the layout. Note that the Job Labels option shown in this 
right click menu lets you show/hide the filename labels as shown in grey and red 
in the illustration above. The Show Grid option lets you show/hide the grid lines in 
your layout window.

Some tasks can only be performed on multiple images. If you do not have multiple 
files selected, you will notice that some menu options become “grayed out”

l.	 Automated Smart NestingTM.
Whether you prepare your images directly in the layout 
window, or hold single jobs to arrange later, you can use 
SoftRIP’s Smart NestingTM to create efficient layouts. Smart 
NestingTM offers several automated nesting options to bal-
ance your priorities for saving media and guillotine trim-
ming time. The Allow Rotations setting saves even more 
media by rotating un-RIP’d files any time that rotation will 
make the overall layout more efficient.

Tightest Fit creates a layout that will save the most media. Layouts made with 
Tightest Fit typically cannot be trimmed with a guillotine trimmer.
Super Easy Cut positions images to result in the fewest number of cuts. In this 
mode, the layout can be trimmed with a single horizontal trim for each row, and 
then just a series of vertical cuts.
Easy Cut is a “best of both” option 
that works to save both media and 
trimming time. This option posi-
tions images to be trimmed with 
straight cuts making horizontal 
cuts first, second cuts vertically, 
then continuing to rotate horizon-
tal and vertical cuts until all im-
ages are trimmed.
Simple Nesting positions images 
in the order imported, or for RIP’d 
images the order listed on the 
Print Queue

m.	Customizing Layouts.
SoftRIP provides additional tools to streamline the process of manually manipulat-
ing layouts to achieve individualized nesting objectives. For these tools, the pri-


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mary selection (indicated by a solid green outline) will be the image that the other 
selected images (shown with dashed green outlines) are aligned or sized to. Note 
that some of these tools are only available when multiple images are selected.

Align Images : Horizontally aligns tops, middles, and bottoms or vertically aligns 
to left, center, or right.
Space Evenly : Evenly distributes the images by moving them so that the space 
between each box is the same—either across or down.
Make Same Size : Makes all selected images the same width or height as the 
first image selected.
Snap to Grid: Snaps an image to the nearest grid point (snap occurs when moved 
image is released by mouse).

n.	 Printing Layouts
Selecting RIP or RIP and Print from the Print Menu will submit the layout for pro-
cessing. Learn about RIPing and Printing Layouts in the Print Controls section of 
online help.

10.3	 Queues Tab
When the Queues tab is selected, the view becomes the master production control 
station of the RIP. On the Queues tab, all RIP and Print queues are displayed with the 
status of each job updated in real time.

a.	 View Settings in the queue tab.

Queues Screen Layout Options : Queue lists and related utilities can be displayed 
for any or all configured Print Units. To display the Queue information for a Print 
Unit, check the box for that printer. When you check more than one box, the screen 
will reformat itself to display information for all selected print units. You may also 
select either the Horizontal or Vertical boxes next to the Orientation listing in the 
upper left hand section.

b.	 Working with RIP Queues
When a job is in the RIP Queue waiting to be processed, it will show an R in the RIP 
column. If it has been submitted to RIP and then print, it will appear with the num-
ber of copies to print in the Copies column. Zeros in both columns indicate that that 

the job is not queued to RIP, either 
because it was not submitted to 
RIP or has already RIP’d. Note that 
the queue entry contains informa-
tion about the source file location 
and modifications made to the im-
age in SoftRIP. If the source file is 
moved or deleted prior to RIPing it 
cannot be processed.

Selecting a job in the RIP queue 
will activate the other buttons on 
the queue-specific tool bar. You 
may change settings for the job us-
ing the tool bar or by right-clicking 
on the job. Multiple jobs can be se-
lected using the standard Windows 
CTRL and SHIFT buttons. Note 
that some actions listed below 
can be launched for jobs individu-
ally, while others can be applied to 
multiple jobs simultaneously.


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Open the Source File for the Selected Job.
Opens the selected job on the Job tab (can only be used with individual jobs). 
This selection will close any images already open on the Job tab.

RIP the Selected Job(s).
Initiates the RIP process for job or jobs selected. 
When RIP process is complete, job(s) will appear in 
the print queue with zero copies.

RIP and Print the Selected Job.
Initiates the RIP and Print process for job or jobs se-
lected. When RIP process is complete, job(s) will ap-
pear in the print queue with default of 1 copy.

Cancel all operations for the selected job(s).
Cancels any RIP or Print processes requested for the job, leaving the job in the 
queue for future processing. Note that this will not cancel processing if RIPing 
has already begun.

Add the selected job(s) to the current layout.
Opens selected job(s) on the layout tab.

Delete the selected job(s).
Cancels any processes requested for the job or job(s) and removes them from 
the RIP Queue. This option does not delete the source file.

Show the Properties for the selected job(s).
This operation of this selection is based on the number of jobs are selected. For 
a single job, Show Properties can also be launched by double clicking the job.

Properties for Individual Jobs
Show Properties for a single job will launch the RIP Queue window. Entries 
made on this screen will not be submitted until the OK button is clicked. If 
OK is not clicked, changes will not be executed.

RIP at First Opportunity will submit the job for RIPing, 
and enable the Copies to print control. If copies is set 
to zero the job will be RIP’d only. A quantity greater 
than zero indicates that the job should be RIP’d with 
the specified number of copies printed.

Delete will remove the job from the RIP Queue.

Re-Name Job : The window in the center of the screen 
displays the name of the job as submitted to the RIP 
queue. Change it by entering a new name. When you 
click OK, the RIP Queue’s Job Name column will be 
updated for the Job. When the job is RIP’d, the Print 
Queue Notes column will also reflect the new name.

Delete PostScript after RIP will delete your source file 
from disk after the file has been RIP’d. This utility is 
useful for saving disk space automatically.

Delete After Printing deletes the Print Queue entry 
after printing is complete. RIP’d files can be sizable, 
especially for jobs with high DPI and large output 

size. Automatically removing these jobs from the Print Queue can be critical 
if you have limited disk space.

Comment allows you to enter a job comment message to be printed below 
the job. This comment will print along with any Annotate Prints settings se-
lected in the unit Setup screen. Unlike the comments entered in the Setup 
screen’s Annotate Prints window which will apply to all jobs printed with 
that print unit, Job Comments entered here will apply to this job only. The 
Annotation box on the Setup screen must be checked in order for messages 
entered in the Job Comments window to print with the job.
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Properties for Multiple Jobs
When you highlight multiple RIP Queue 
entries and select “Show the Properties 
for the selected job(s)” you will launch the 
screen shown on the right. Note that only 
select batch processing options are avail-
able for multiple entries.

c.	 Working with Print Queues
Jobs are queued to print when they display a quantity greater than zero. If no func-
tions to suppress printing are selected on the Unit Options tab, queued print jobs 
will begin printing immediately in the order they are listed in the queue. Units held 
for future nesting will display a quantity to print without initiating printing.
When job(s) in the Print Queue window are selected, the queue-specific tool bar will 
become active. As with the RIP queue, some actions can be launched for jobs indi-
vidually only, while others can be applied to multiple jobs simultaneously. “Cancel 
all operations for the selected job(s)” and “Delete the selected job(s)” work similarly 
to the same options in the RIP Queue. Additional Print Queue operations are as fol-
lows:

Print the Selected Job.
Initiates the RIP and Print process for job or jobs selected, entering the default 
quantity of one. Clicking the printer button on the tool bar will add additional 
copies to print one at a time.

Add the selected job(s) to the current layout.
Opens selected job(s) on the layout tab. Since jobs listed in the print queue are 
already RIP’d, they will be displayed on the Layout tab with solid blue outlines. 
RIP’d images cannot be edited or rotated in the layout without re-RIPing. Learn 
more about this in the Layout section of online help.

Layout Queued Job(s) toolbar button.
In conjunction with the Hold for Layout option this control will add all jobs 
queued to print to the layout tab and change their quantities in the Print Queue 
to zero. You may decide whether to add the jobs to a layout already in progress 
or to clear the current layout tab contents before sending queued jobs to lay-
out.

Show the Properties for the selected job(s).
Launches the Print Queues window. The Delete button 
here will remove the entry from the Print Queue only. 
Note that the job name entry window will change the 
listing in the Print Queue only; it will not update to 
the RIP queue entry for the job. You can also change 
the job name shown in the Notes column by selecting 
Edit Notes from the Print Queue right click menu.
When selecting multiple jobs, only Copies to print and 
Delete are available options. As with the correspond-
ing RIP Queue properties screens, changes will only 
take place if you exit these windows by pressing OK.
 

d.	 Master Queues Drag-and-Drop Actions
If an image does not require any file preparation, you can drag and drop it directly 
from the file browser tab to a RIP Queue. You will be asked whether or not you 
would like to generate a preview. If you select not to generate a preview, the image 
will display as “Preview not available” when added to a layout.
You can also drag and drop files between Queues for fast processing. Any time you 
drag a queue entry to a print unit that does not have an identical setup, you will be 
informed that you must RIP the file with the destination unit’s Imaging Configura-
tion. When dragging directly to a Print Queue, the file will be submitted to the RIP 
Queue, and the RIP Queue Edit window will automatically launch. Check “Print at 
first opportunity” and select the number of copies to print to RIP the job and for-
ward it to the Print Queue.
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e.	 Important Note
You must always make sure that the Queue Processing Active at the top of the main 
screen is checked. When this box is unchecked jobs currently in progress will finish 
but no new jobs will begin processing. This safety setting is useful when you need 
to stop your production in a hurry, but can create problems if it is unchecked by 
accident. When the box is unchecked, it will flash red and read “Queue Processing 
Not Active”. Jobs are not RIP’d or Printed when the box is unchecked.


